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Table of Standards
Photographs
Preservation Master

CONTENTdm Version

Access/Web Version

8-bit grayscale (for black/white) or
true color
(48-bit)
600 dpi
Uncompressed TIF
3000 pixels along long dimension
No post-color correction or
touching up/repair
Crop only to photo paper edge

8-bit grayscale (for black/white) or
true color
(48-bit)
300 dpi
JPEG
3000 pixels along long dimension
No post-color correction or
touching up/repair
Crop only to photo paper edge
UALR bar must be added

8--bit grayscale (for
black/white) or true color
(48-bit)
72 dpi
JPEG
1024 pixels along long
dimension
Color correction or touching
up/repair is allowed in certain
circumstances

Photographs: 35 mm Negatives, Slides, and Contact Sheets
Preservation Master

CONTENTdm Version

Access/Web Version

8-bit grayscale (for black/white) or
true color
(48-bit)
2100 dpi
Uncompressed TIF
3000 pixels along long dimension
Only prescribed correction or
touching up/repair is allowed (see
guidelines for more detail)
Crop until there is a thin border
outside the image

8-bit grayscale (for black/white)
or true color
(48-bit)
300 dpi
JPEG
3000 pixels along long dimension
No post-color correction or
touching up/repair
Crop until there is a thin border
outside the image
UALR bar must be added

8-bit grayscale (for black/white)
or true color (48-bit)
72 dpi
JPEG
1024 pixels along long
dimension
Color correction or touching
up/repair is allowed in certain
circumstances

Audio
Preservation Master
Sample rate is 96,000 (Hz)
Uncompressed wav
Original size
No correction or touching
up/repair
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CONTENTdm Version
Sample rate is between 44,100 48,000 (Hz) MP3
Correction or touching up/repair is
allowable in certain circumstances

Access/Web Version
Sample rate is between 44,100 48,000 (Hz) MP3
Correction or touching up/repair
is allowed in certain
circumstances
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Maps, Plans, and Oversized
Preservation Master

CONTENTdm Version

Access/Web Version

8-bit grayscale (for black/white)
or
true color
600 dpi for size up to 11x17; 570
dpi above 11x17
Uncompressed TIF
8000 along long dimension
No post-color correction or
touching up/repair
Crop only to paper edge

8-bit grayscale (for black/white)
or true color
300 dpi for size up to 11x17; 200 dpi
above 11x17
JPEG
3000 along long dimension
No post-color correction or
touching up/repair
UALR bar must be added

8-bit grayscale (for
black/white) or true color
(48-bit)
72 dpi
JPEG
1024 pixels along long dimension
Color correction or touching
up/repair is allowed in certain
circumstances

Graphic Materials (line drawings, lithographs, watercolors)
Preservation Master
8-bit grayscale (for black/white)
or true color
600 dpi for size up to 11x17; 570
dpi above 11x17
Uncompressed TIF
Materials up to 11x17 are 3000
pixels along long dimension;
materials larger than 11x17 are
8000
No post-color correction or
touching up/repair
Crop only to paper edge
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CONTENTdm Version

Access/Web Version

8-bit grayscale (for black/white)
or true color
300 dpi for size up to 11x17;
200 dpi above 11x17
JPEG
Materials up to 11x17 are 3000
pixels along long dimension;
materials larger than 11x17 are
original size
No post-color correction or
touching up/repair
Crop only to photo paper edge
UALR bar must be added

8-bit grayscale (for
black/white) or true color
72 dpi
JPEG
1024 pixels along long dimension
Color correction or touching
up/repair is allowed in certain
circumstances
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Documents
Preservation Master

CONTENTdm Version

1-bit bitonal (for pure
black/white); otherwise, 8-bit
grayscale or true color (48-bit)
400 dpi
Uncompressed TIF
Original size
No color correction, touching up, or
repair

Access/Web Version

1-bit bitonal (for pure
black/white); otherwise, 8-bit
grayscale or true color (48-bit)
300 dpi
JPEG
Original size
No post-color correction or
touching up/repair
OCR is allowed
UALR bar must be added

1-bit bitonal (for pure
black/white); otherwise, 8bit grayscale or true color (48-bit)
72 dpi
JPEG
Original size
Correction or touching up/repair
is allowed in certain
circumstances
OCR is allowed

CONTENTdm Version

Access/Web Version

Videos
Preservation Master
AVI
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mpeg4

.wmv (YouTube streaming)
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Digitizing Photographs
Any special needs of the collection found during the selection process (e.g., whether
special equipment is necessary for digitization or accession numbers need to be
assigned), should be addressed before beginning the scanning process. For scanning inhouse, CAHC uses the Epson Expression 10000XL- Photo Scanner and 11000XL- Photo
Scanner.

Scanning the Preservation Master
The preservation master is the highest-quality digital surrogate of the physical
photograph. Because it should accurately represent the original photograph, this digital
copy should not be altered for aesthetic reasons.
Note: Photographs and
1. Turn on the Epson scanner
2. Open EPSON Scan, the software that will be used for
scanning, and make sure you are in “Professional Mode.”
3. Adjust the following based on the Table of Standards.

negatives should only be
handled by their edges. To
avoid touching their surface,
wear cotton gloves.

Example: Settings for a
color photographic print
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For Photographic Prints
1. Place the photograph face-down on the scanning bed in the upper left-hand corner.

2. Set the Image Type and Resolution to their respective specifications.
3. Make sure the Auto Exposure Type field is set to Photo.
4. Make sure the Document Type and Document Source are at their default settings of
Reflective and Document Table.
5. Under Auto Exposure Type, select Photo.
6. Preview the photograph before scanning. In the preview window, click and drag the
cursor so that the box covers the entire photograph, including its paper edges. If there
are no paper edges, then leave a small amount of white space around the image.

If your photo needs to be cropped or deskewed and you’re unable to do it in the
preview window, adjust it post-scan in Photoshop after it is saved. See instructions
under the Cropping and Deskewing section.
7. Determine whether the width or height is the long side. Set the long side (either “W” or
“H”) under Target Size to 3,000 pixels and hit the lock button so that it shows a closed
lock. No other changes to the photograph are allowed unless it needs to be rotated or
skewed.

Revised:
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8. If the photograph is sepia-toned (i.e., has a brown tone), under the adjustments
section, click Reset. Otherwise, ignore this section, except for making sure all
adjustments are unchecked.

9. Click Scan. A new window will appear to ask where to save the scan.

For Negatives
1. Place negatives in film holder shiny side face-down.
2. Place the film holder on the scanning bed, with the document cover removed and the
transparency guide placed at the back edge of the scanning bed.
3. Set the Image Type and Resolution to their respective specifications. Change the
Document Type to Film and Film Type to whatever type the negative is.
4. Preview the negative before scanning. In the preview window, click and drag the cursor
so that the box covers the entire negative, including a thin outer edge.
If your negative needs to be cropped or deskewed and you’re unable to do it in the
preview window, adjust it post-scan in Photoshop after it is saved. See instructions
under the Cropping and Deskewing section.
5. Determine whether the width or height is the long side. Set the long side (either “W” or
“H”) under “Target Size” to 3,000 pixels and hit the lock button so that it shows a closed
lock.
6. Make the following changes under the adjustments section:

For black and white negatives:
Keep everything as is. Do not reset.
12
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For color negatives
Click Reset. Then check the Color Restoration box.
Click Scan. A new window will appear to ask where to save the scan.

For Slides
1. Place slides in the slide holder shiny side face-down
2. Place the slide holder on the scanning bed, with the document cover removed and
the transparency guide placed at the back edge of the scanning bed.
3. Set the Image Type and Resolution to their respective specifications.
4. Change the Document Type to Film and Film Type to whatever type the slide is
(most likely “Positive Film”).
5. Preview the slide before scanning. In the preview window, click and drag the cursor
so that the box covers the entire slide, including a thin outer edge.
If your slide needs to be cropped or deskewed and you’re unable to do it in the
preview window, adjust it post-scan in Photoshop after it is saved. See instructions
under the Cropping and Deskewing section.
6. Determine whether the width or height is the long side. Set the long side (either “W”
or “H”) under Target Size to 3,000 pixels and hit the lock button so that it shows a
closed lock.
7. Make the following changes under the adjustments section:

For black and white slides:
Keep everything as is. Do not reset.

For color positive and negative slides:
Click Reset. Then check the Color Restoration box.
8. Click Scan. A new window will appear to ask where to save the scan.

Revised:
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Cropping and Deskewing
The only allowable changes to the preservation master include cropping and skewing. If
you need to do either, open Adobe Photoshop.
To crop:
1. Select the Cropping tool in the left-hand side bar:

2. Using your cursor, select the area of the image you would like to retain. Be sure to
include a thin border of blank space around the image.

3. Go to Image in the top menu bar, then select Crop.
4. Save your changes to the cropped image.
To skew:
1. Go to Image in the top bar and select Image Rotation, then select Arbitrary.

Revised:
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2. In Arbitrary, input the number of degrees by which you would like to adjust the
image and select whether it should be skewed clockwise or counterclockwise. For
slightly crooked images, a degree of 1 will often straighten it.

3. Click OK. You may need to experiment with different degrees. Undo undesired
changes by going to Edit and Undo.
4. Once finished, Save your changes.
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Saving and Naming the Preservation Master
The file name will reflect the finding aid’s numbering system. How the file name will be
constructed depends upon whether photographs are grouped together in a collection or
are dispersed throughout a collection. The following is a guide to the terminology used
in saving files:

Definitions
• ualr: Every file name will have ualr at the beginning to emphasize it belongs to
UALR CAHC.
• ms: ms is the abbreviation for manuscripts. If the photograph belongs to a
manuscript collection, then use ms before the collection number.
• ph: If the photograph belongs to a photograph collection (and not a manuscript
collection), then use ph before the collection number.
• Record group/series/subseries numbers: A manuscript or photograph collection
may be divided into record group, series, or subseries. If this is the case, then
include these numbers number in the file name.
• Image number: Use pho before the number. The number will be the same as the
identification number given to the original photograph.
• Version: Designate the image version using one of the following abbreviations:
pm = preservation master, dm = CONTENTdm version, aw = access/web version,
and ot = other
• File type: File names should end according to its format (e.g., “tif”)

Additional Notes:
•

Use lower-case letters when naming files.

•

Use underscores or dashes to represent spaces (e.g., ualr-0001_07 instead of
ualr.0001.07).

•

Use na if a field in the file name does not apply

Naming templates
To name photographs that are grouped together in a series or subseries and
individually numbered, use the following template:
ualr-

Revised:

ms or ph#_

RG# or Series#_

Series or Subseries#_

Pho#_

Ver.

Type
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To name photographs that are dispersed throughout a collection, use the following
template:
ualr-

ms or ph#_

RG# or
Series#_

Series or
Subseries#_

Box#_

Folder#_

Pho#_

Ver.

Type

Naming photographs grouped together and individually identified
For a preservation master copy belonging to the Van Buren Scenes photograph collection,
photograph number 1, this template illustrates how the file name would be derived:
ualr-

ms or ph#_

RG# or Series#_

Series or Subseries#_

Pho#_

Ver.

Type

ualr-

ph-0001_

na_

na_

pho0001_

pm.

tif

ualr-ph-0001_na_na_pho0001_pm.tif

Naming photographs dispersed throughout a collection
For a photograph from the John Barker papers, series 1, box 2, folder 6, the file name would
be derived using this format:
ualr-

ms or ph#_

RG# or
Series#_

Series or
Subseries#_

Box#_

Folder#_

Pho#_

Ver.

Type

ualr-

ms-0050_

01_

na_

02_

06_

pho01_

pm.

tif

ualr-ms-0050_01_na_02_06_pho01_pm.tif

Saving the Preservation Master
The EPSON Scan software will automatically number photographs by sequence. You can
temporarily save the TIF to your local computer, but you will ultimately need to move the
digital files to the N:\ drive.
Fix the file name to the above specification.
Note: When putting in numbers for boxes, folders, and
documents, add preceding 0s based on the total number of
boxes in a record group/series, folders in a box, and
photographs in a folder (e.g., box 020 for a collection with
over a hundred boxes versus box 20 for a collection with 25
boxes total).

Proceed to create the CONTENTdm copy.
Whenever you create a preservation master, note its creation in the
“Item_Digital_Use_Log” under the “Scanned Images and Usage” tab, located on the N:\
18
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drive in the Logs folder. List the item’s identifier in the first column, the date scanned in
the next, and finally what version of the digitization guidelines you followed when
creating the scan (e.g., for these guidelines, the version number is 3).

Creating the CONTENTdm Version
From the Preservation Master, create the CONTENTdm version, which will be uploaded to
CONTENTdm. Open the preservation master in Photoshop and change the specifications
to the following:
1. In Image, under Image Size, change the Resolution to 300 dpi
2. Under Pixel Dimensions, change the long side (the largest number in width or
height) to 3000 pixels.
3. Click Save As under the File menu
4. Type “dm” next to the image title
5. Under Format, choose JPEG
6. Click Save
7. Drag the slider until the status says “High” in the JPEG Options dialog box
8. Click OK

Batch Conversions
For batch conversions, use the Photoshop macros in the “Digitization Projects” folder
under “Photoshop Macros.” Select the “CONTENTdm_height” macro or the
“CONTENTdm_width” macro based on whether the height or width is the photograph’s
long side.
Revised:
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If you use the Photoshop macro, it will automatically save converted images to the N:
drive in the “Transfers_CONTENTdm” folder under “Digitization Projects” in the
photographs folder. Move these files to its appropriate collection and under the
“CONTENTdm” folder.

Saving the CONTENTdm Version
DO NOT SAVE OVER THE PRESERVATION MASTER
Moving Preservation and CONTENTdm Versions to Folders
1. On the N:\ drive, find the folder titled “Digitization Projects.”
2. Click on the Photograph folder, and then locate the specific file folder for the project,
which will be named by its collection number. Open this folder.
3. There will be an additional two folders: “Preservation Master” and “CONTENTdm.”
4. Save the TIF file in the “Preservation Master” folder and the JPEG in the “CONTENTdm”
folder. Once transferred, discard the copies in “My Pictures.”

Uploading Photographs into CONTENTdm
Getting started
To add digital objects to CONTENTdm, you will need to work with CONTENTdm Project
Client. If this is your first time working in Project Client, you will need to create a log-in
account in World Cat. Contact the Director of Technology and Digital Initiatives with your
World Cat log-in information for access to Project Client.
1. Once you’re in the Project Client, click New in the Project menu. Enter your log-in. The
Server URL is: https://server15728.contentdm.oclc.org/
2. In the next screen, choose the appropriate collection you want to import. Collection
names are based off of media types. This will serve as a workspace for adding metadata
to digital photographs. Alternatively, you can also work in an Excel Spreadsheet to
upload metadata. Please contact the Coordinator of Multimedia with instructions on
how to do so.

Instructions for uploading photographs to
CONTENTdm
Open the CONTENTdm Project Client and select the
appropriate project.

For a single item:
1. Under Common Tasks, click Add Item.
20
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2. Under Specify the file, click Browse next to the File Name field. Find the CONTENTdm
derivative copy. Click Open.
3. Click Add at the bottom of the Add Item box. The image should appear on the Project
Spreadsheet.

For multiple items:
1. Place all items into a single folder.
2. In the Project Client, under Common Tasks, click Add
Multiple Items.
3. Click Import from a Directory.
4. Click Browse and select the folder with the CONTENTdm
derivative copies.
5. Click Open.
6. Click Next at the bottom.
7. In the next screen, click Add Items. The audio recordings should appear on the Project
Spreadsheet.

For compound items
1. Place the compound object into a single folder.
2. In the Project Client, under Common Tasks, click Add
Compound Objects.
3. In the Add Multiple Compound Objects screen, click Add
next to Compound Object Wizard. For photographs
with two sides, click Postcard.
4. In the next screen, select the folder in which you saved the compound object. Click
Next.
5. Under Page Information, click Label Pages Using Sequence, and change Page to Side.
6. In the next screen, Click Finish.

Adding metadata
Please see the “UALR CAHC Photographs Metadata” spreadsheet available on the O drive
for further instructions on filling out the metadata fields. Once the metadata is complete,
save it and upload it for approval.

Metadata template
All photographs use the UALR bar. To add the bar, select Edit Metadata Template, and
then select Images & Thumbnails on the sidebar. Under “Image Rights,” select name “ualr”
with the type “band.” Close out of this menu.
Revised:
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Approval
Once the project is complete, the Coordinator of Multimedia will approve the new items
before they are accessible on the web. Along with checking metadata in CONTENTdm,
the Coordinator of Multimedia will also confirm whether the digital copies meet CAHC’s
standards.
Preservation masters meeting standards will be transferred to the O:\drive. Once
available on CONTENTdm, CONTENTdm photographs meeting standards will be
discarded from the N:\ drive.

Content DM Approval and Indexing
The Coordinator of Multimedia will check photographs for the accurate use of metadata
and assign subject headings to photographs. Once complete, the Coordinator of
Multimedia will approve the photographs.

Creating Web Access Copies
For digital exhibits, CAHC will create web-access copies of photographs.

Using Adobe Photoshop to batch create web access derivatives
Adobe Photoshop can batch create web-access copies. For batch conversions, use the
Photoshop macros in the Digitization Projects folder under Photoshop Macros. Select
the Web_height macro or the Web_width macro based on whether the height or width
is the photograph’s long side.
If you would like to adjust photographs manually, use the following specifications:
• 72 dpi
• JPEG (high quality)
• 1024 pixels along long dimension

Saving web access copies
If you use the Photoshop macro, it will automatically save converted images to the N: drive
in the Transfers_Web folder under Digitization Projects in the photographs folder.
Move these files to its appropriate collection and under the Web Access folder. Make sure
the version portion of the file name is changed to aw.

22
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Digitizing Documents
Any special needs of the collection found during the selection process (e.g., whether
special equipment is necessary for digitization), should be addressed before beginning the
scanning process.

Scanning the Preservation Master
The Preservation Master is the highest-quality digital surrogate of the physical document.
Because it should accurately represent the original document, this digital copy should not
be altered for aesthetic reasons.
1. Turn on the Epson scanner
2. Open EPSON Scan, the software that will be used for scanning, and make sure you
are in Professional Mode.
To set the correct specifications in EPSON Scan, adjust the following based on the Table of
Standards.
•

Set the Image Type and Resolution to their respective specifications.

•

Make sure the Auto Exposure Type field is set to Document.

•

Set Document Type and Document Source to their default settings of Reflective
and Document Table.

•

Preview the document before scanning. In the preview window, click and drag the
cursor so that the box covers the entire document. Determine whether the width or
height is the long side. Set the long side (either “W” or “H”) under Target Size to
3,000 pixels.

•

Click the Lock button so that it shows a closed lock.

•

Under the Adjustments section, click Reset. Make sure all adjustments are
unchecked.

3. Click Scan. A new window will appear to ask where to save the scan.
4. Proceed to create the CONTENTdm copy.
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Saving and Naming the Preservation Master
The file name will reflect the finding aid’s numbering system. The following is a guide to
the terminology used in saving files:

Definitions
•

ualr: Every file name will have ualr at the beginning to emphasize it belongs to
UALR CAHC.

•

ms: ms is the abbreviation for manuscripts. If the document belongs to a manuscript
collection, then use ms before the collection number.

•

ph: If the document belongs to a photograph collection (and not a manuscript
collection), then use ph before the collection number.

•

Record group/series/subseries numbers: A manuscript or photograph collection
may be divided into record group, series, or subseries. If this is the case, then include
these numbers number in the file name.

•

Document number: Use doc before the number.

•

Version: Designate the image version using one of the following abbreviations: pm
= preservation master, dm = CONTENTdm version, aw = access/web version, and ot
= other

•

File type: File names should end according to its format (e.g., “tif”)

•

Additional Notes:
•
•
•

Use lower-case letters when naming files.
Use underscores or dashes to represent spaces (e.g., ualr-0001_07 instead
of ualr 0001 07).
Use na if a field in the file name does not apply
Note: When putting in numbers for boxes, folders, and
documents, add preceding 0s based on the total number of
boxes in a record group/series, folders in a box, and
photographs in a folder (e.g., box 020 for a collection with
over a hundred boxes versus box 20 for a collection with 25
boxes total).

The following is an example of how to format a file name. For a preservation master copy
belonging to the Winthrop Rockefeller collection, in record group 4, box 20, folder 14, this
template illustrates how the file name would be derived:
ualr-

ms or ph#_

RG# or
Series#_

Series or
Subseries#_

Box#_

Folder#_

Doc#_

Ver.

Type

ualr-

ms-0001_

04_

na_

020_

14_

doc01_

pm.

tif

ualr-ms-0001_04_na_020_14_doc01_pm.tif
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Saving the Preservation Master
To save it, on the N:\ drive, find the folder titled “Digitization Projects.” Then click on the
Documents folder, and then locate the specific file folder for the project, which will be
named by its manuscript collection number. Open this folder. Save this file in the
“Preservation Master” folder.
Whenever you create a preservation master, note its creation in the
“Item_Digital_Use_Log” under the “Scanned Images and Usage” tab, located on the N:\
drive in the Logs folder. List the item’s identifier in the first column, the date scanned in
the next, and finally what version of the digitization guidelines you followed when
creating the scan (e.g., for these guidelines, the version number is 3).

Creating the CONTENTdm Version
From the Preservation Master, create the CONTENTdm version, which will be uploaded to
CONTENTdm. Open the preservation master in Photoshop and change the specifications
to the following:
1. In Image, under Image Size choose 300 dpi
2. Under Pixel Dimensions, change the long side (the largest number in width or
height) to 3000 pixels.
3. Click Save As under the File menu
4. Type “dm” next to the image title
5. Under Format, choose JPEG
6. Click Save
7. Drag the slider until the status says “High” in the JPEG Options dialog box
8. Click OK

Batch Conversions
For batch conversions, use the Photoshop macros in the “Digitization Projects” folder
under “Photoshop Macros.” Select the “CONTENTdm_height” macro or the
“CONTENTdm_width” macro based on whether the height or width is the document’s
long side.
If you use the Photoshop macro, it will automatically save converted images to the N:
drive in the “Transfers_CONTENTdm” folder under “Digitization Projects” in the
Documents folder. Move these files to its appropriate collection and under the
“CONTENTdm” folder.

Saving the CONTENTdm Version
DO NOT SAVE OVER THE PRESERVATION MASTER
26

Revised: January 13, 2015

Digitization Manual, V.3

Moving Preservation and CONTENTdm Versions to Folders
1. On the N:\ drive, find the folder titled “Digitization Projects.”
2. Click on the Documents folder, and then locate the specific file folder for the project,
which will be named by its collection number. Open this folder.
3. There will be an additional two folders: “Preservation Master” and “CONTENTdm.”
4. Save the TIF file in the “Preservation Master” folder and the JPEG in the “CONTENTdm”
folder. Once transferred, discard the copies in “My Pictures.”

Uploading into CONTENTdm
Getting started
To add digital objects to CONTENTdm, you will need to work with CONTENTdm Project
Client. If this is your first time working in Project Client, you will need to create a log-in
account in World Cat. Contact the Director of Technology and Digital Initiatives with your
World Cat log-in information for access to Project Client.
1. Once you’re in the Project Client, click Create New Project in the Add menu.
Enter your log-in. The Server URL is: https://server15728.contentdm.oclc.org/
2. In the next screen, choose the appropriate collection you want to import.
Collection names are based off of media types. This will serve as a workspace for
adding metadata to digital documents. Alternatively, you can also work in an
Excel Spreadsheet to upload metadata. Please contact the Coordinator of
Multimedia with instructions on how to do so.

Instructions for uploading documents to CONTENTdm
Open the CONTENTdm Project Client and select the appropriate project.

For a single item:
1. Under Common Tasks, click Add Item.
2. Under Specify the file, click Browse next to the File
Name field. Find the CONTENTdm derivative copy. Click
Open.
3. Click Add at the bottom of the Add Item box. The image should appear on the Project
Spreadsheet.

For multiple items:
1. Place all items into a single folder.
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2. In the Project Client, under Common Tasks, click Add
Multiple Items.
3. Click Import from a Directory.
4. Click Browse and select the folder with the CONTENTdm
derivative copies.
5. Click Open.
6. Click Next at the bottom.
7. In the next screen, click Add Items. The documents should appear on the Project
Spreadsheet.

For compound items:
1. Place the compound object into a single folder.
2. In the Project Client, under Common Tasks, click Add
Compound Objects.
3. In the Add Multiple Compound Objects screen, click Add
next to Compound Object Wizard. For recordings with
multiple parts, click Document.
4. In the next screen, select the folder in which you saved
the compound object. Click Next.
5. Under Page Information, click Label Pages Using Sequence, and change Page to Part.
6. In the next screen, Click Finish.

Adding metadata
Please see the “UALR CAHC Documents Metadata” spreadsheet available on the O drive
for further instructions on filling out the metadata fields. Once the metadata is complete,
save it and upload it for approval.

Approval
Once the project is complete, the Coordinator of Multimedia will approve the new items
before they are accessible on the web. Along with checking metadata in CONTENTdm,
the Coordinator of Multimedia will also confirm whether the digital copies meet CAHC’s
standards.
Preservation masters meeting standards will be transferred to the O:\drive. Once
available on CONTENTdm, CONTENTdm documents meeting standards will be discarded
from the N:\ drive.

Content DM Approval and Indexing
The Coordinator of Multimedia will check photographs for the accurate use of metadata.
In addition, the Coordinator of Multimedia will assign subject headings to documents.
28
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Once complete, the Coordinator of Multimedia will approve the documents.

Web Access
For digital exhibits, CAHC will create web-access copies of documents.

Using Adobe Photoshop to batch create web access derivatives
Adobe Photoshop can batch create web-access copies. For batch conversions, use the
Photoshop macros in the Digitization Projects folder under Photoshop Macros. Select
the Web_height macro or the Web_width macro based on whether the height or width
is the document’s long side.
If you would like to adjust documents manually, use the following specifications:
• 72 dpi
• JPEG (high quality)
• 1024 pixels along long dimension

Saving web access copies
If you use the Photoshop macro, it will automatically save converted images to the N: drive
in the Transfers_Web folder under Digitization Projects in the photographs folder.
Move these files to its appropriate collection and under the Web Access folder. Make sure
the version portion of the file name is changed to aw.
For digital exhibits, CAHC will create web-access copies of documents.

Revised:

29

Digitization Manual, V.3

Digitizing Audio
Any special needs of the collection found during the selection process (e.g., whether
special equipment is necessary for digitization or accession numbers need to be
assigned), should be addressed before beginning the scanning process. The equipment
to digitize audio recordings is found in the cabinet located in the Digital Services Lab.

Capturing the Preservation Master
Reel-to-Reel
For audio on reel-to-reels, use the audio analog-to-digital converter, TEAC X-300R.

1. Place the left plug in output 14 and the right output in output 13
2. Pull out the drawer that holds the tape machine and turn the key to lock
3. Switch the main power to ON
4. Load film onto reels

30
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Using the machine
1. Pull the drawer out and lock the shelf to keep the machine from pushing back into
the cabinet.
2. Place reel with film onto the left spool and the empty reel on the right spool.
3. Turn the spool counter-clockwise to lock the reel into place.
4. Feed the film into the machine. Follow this diagram to correctly load the film.

5. Once the film reaches the right side of the machine, feed the film into the center
notch inside the reel.

6. Once the film is threaded into the second reel, turn the reel two to three times to
secure the film.
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7. Press the power button.
8. Make sure the “gain” dials above the cassette player are at equal settings:

9. Open Audacity. Open Audacity. Set Audacity to the following specifications
10. Set the mic to the highest volume

11. Next to the mic’s drop down menu, make sure “Line in” is selected

12. Set the Project Rate to (Hz) to 96,000

13. Perform a test recording. Play and record the audio recording, listening using the
headphones directly plugged into Scarlett. Assess the quality for the following:
a. If the speakers are unintelligible because the recording is playing quickly,
adjust the speed by pushing the Speed button. If it does not improve
sound quality, contact the Coordinator of Media.
b. Determine whether the reel-to-reel output dial is satisfactory at 5 or
improves when increased (do not go past 8).
c. Finally, stop recording. Unplug the headphones from Scarlett and plug the
headphones into the computer. Play the recording back. Does everything
sound normal? If not, please contact the Coordinator of Media.
14. Erase the test recording by clicking the x in the top left corner and plug the
headphones into Scarlett.
15. Rewind to a point right before the audio begins.
16. Click the record button in Audacity and then hit play on the machine. Let it play until
you no longer hear audio. At that point, hit stop in Audacity and then stop on the
machine.
17. Save the recording, first exporting as a .wav file and then exporting as an .mp3 file
(which will automatically reduce it to 48,000 (Hz)).
18. If the reel is two-sided, under “Direction,” select the left button and record the other
side.
32
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Cassette Tapes
For audio on cassettes, use the Dolby HX Pro.
1. Place the left plug in output 16 and the right output in output 15.
2. Place the cassette in slot one with Side A facing out.
3. Plug the USB cord from the cabinet into the computer.
4. Make sure the “gain” dials above the cassette player are at equal settings:

5. Open Audacity. Set Audacity to the following specifications
6. Set the mic to the highest volume

7. Next to the mic’s drop down menu, make sure “Line in” is selected

8. Set the Project Rate to (Hz) to 96,000

9. Perform a test recording. Play and record the audio recording, listening using the
headphones directly plugged into Scarlett. Assess the quality for the following:
a. If the speakers are unintelligible because the recording is playing quickly or
slowly, contact the Coordinator of Media.
b. Pay attention to the sound output in the visual histogram in Audacity. When
necessary, use the gain dials above the cassette player to adjust the sound.
You want to histogram to look similar to the screenshot on the following
page.
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c. Finally, stop recording. Unplug the headphones from Scarlett and plug the
headphones into the computer. Play the recording back. Does everything
sound normal? If not, please contact the Coordinator of Media.
10. Erase the test recording by clicking the x in the top left corner and plug the
headphones into Scarlett.
11. Rewind to a point right before the audio begins.
12. Click the record button in Audacity and then hit play on the machine. Let it play until
you no longer hear audio. At that point, hit stop in Audacity and then stop on the
machine.
13. Save the recording, first exporting as a .wav file and then exporting as an .mp3 file
(which will automatically reduce it to 48,000 (Hz)).
14. If there is a Side B, press the backward play button () to record the other side (no
need to rewind or flip the tape first if you are at the end of Side A).
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Saving and Naming the Preservation Master
The file name will reflect the finding aid’s numbering system. How the file name will be
constructed depends upon whether audio recordings are grouped together in a
collection or are dispersed throughout a collection. The following is a guide to the
terminology used in saving files:

Definitions
•

ualr: Every file name will have ualr at the beginning to emphasize it belongs to UALR
CAHC.

•

ms or orh: ms is the abbreviation for manuscripts; orh is for the oral history
collection.

•

Record group/series/subseries numbers: A manuscript or photograph collection
may be divided into record group, series, or subseries. If this is the case, then include
these numbers number in the file name.

•

Audio number: Use aud before the number. The number will be the same as the
identification number given to the original audio recording. Do not number audio
recordings based on the sequence in which it is copied.

•

Version: Designate the audio version using one of the following abbreviations: pm =

•

preservation master, dm = CONTENTdm version, aw = access/web version, and ot =
other

•

File type: File names should end according to its format (e.g., “wav”)

Additional Notes:
•

Use lower-case letters when naming files.

•

Use underscores or dashes to represent spaces (e.g., ualr-0001_07 instead of ualr 0001
07).

•

Use na if a field in the file name does not apply

Naming templates
To name recordings that are grouped together and individually identified, use the following
template:
ualr-

ms or ph#_

RG# or Series#_

Series or Subseries#_

Aud#_

Ver.

Type

To name recordings that are dispersed throughout a collection, use the following template:
ualr-

Revised:

ms or ph#_

RG# or
Series#_

Series or
Subseries#_

Box#_

Folder#_

Aud#_

Ver.

Type
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Naming Recordings in the Oral History Collection
For a recording from the Oral History Collection, the file name would be:
ualr-

orh-

Aud#_

Ver.

Type

ualr-

orh-0050_

aud01_

pm.

wav

ualr-orh-0050_aud01_pm.wav

Naming recordings grouped together and individually numbered
The following is an example of how to format a file name. For a preservation master copy
belonging to the Jim Guy Tucker Collection, in record group five, subseries one, reel number
1, this template illustrates how the file name would be derived:
ualr-

ms or ph#_

RG# or Series#_

Series or Subseries#_

Aud#_

Ver.

Type

ualr-

ms-0004

09

01

aud0001

pm.

wav

ualr-ms-0004_09_na_aud0001_pm.wav

Naming recordings dispersed throughout a collection
For a recording from the John Barker Papers, series 1, box 2, folder 6, the file name would be:
ualr-

ms or ph#_

RG# or
Series#_

Series or
Subseries#_

Box#_

Folder#_

Aud#_

Ver.

Type

ualr-

ms-0050_

01_

na_

02_

06_

aud01_

pm.

wav

ualr-ms-0050_01_na_02_06_aud01_pm.wav

Saving the Preservation Master
Click Export under the file menu. Export the audio recording
as a wav file.
Save the wav file in the folder that you created on the
desktop.

When putting in numbers for boxes,
folders, and documents, add
preceding 0s based on the total
number of boxes in a record
group/series, folders in a box, and
audio recordings in a folder (e.g., box
02) for a collection with over a
hundred boxes versus box 20 for a
collection with 25 boxes total).

Whenever you create a preservation master, note its creation in the “Item_Digital_Use_Log” under the
“Scanned Images and Usage” tab, located on the N:\ drive in the Logs folder. List the item’s identifier in the
first column, the date scanned in the next, and finally what version of the digitization guidelines you
followed when creating the scan (e.g., for these guidelines, the version number is 3).
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Proceed to create the CONTENTdm copy.

Creating the CONTENTdm Version
From the preservation master, create the CONTENTdm version, which will be uploaded to
CONTENTdm. Open the preservation master in Audacity and export the file again, this
time as an mp3. It will automatically reduce the Project Rate (Hz) to 48,000

Saving the CONTENTdm Version
1. See the instructions above on naming the file (the name will only differ from the
preservation master by using “dm” instead of “pm” for version and “mp3” instead of
“wav” for file type).
2. After you have named it, save it in the same folder as the Preservation Master.
3.

Once you have both files ready, you will transfer the wav file and the mp3 file (not the
Audacity working files) to the N:\ drive.

In the N:\ drive, find the folder titled Digitization Projects. Find the folder titled
Digitization Projects. In it, locate the audio file. Click on it, and then select the folder
named for the audio recording’s manuscript collection number. Open this folder.
There will be an additional two folders: Preservation Master and CONTENTdm. Place the
audio files in their respective folders. Once transferred, discard the copies on your desktop.
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Uploading Media into CONTENTdm
Getting started
To add digital objects to CONTENTdm, you will need to work with CONTENTdm Project
Client. If this is your first time working in Project Client, you will need to create a log-in
account in World Cat. Contact the Director of Technology and Digital Initiatives with your
World Cat log-in information for access to Project Client.
15. Once you’re in the Project Client, click New in the Project menu. Enter your log-in.
The Server URL is: https://server15728.contentdm.oclc.org/
16. In the next screen, choose the appropriate collection you want to import. Collection
names are based off of media types. This will serve as a workspace for adding
metadata to digital photographs. Alternatively, you can also work in an Excel
Spreadsheet to upload metadata. Please contact the Coordinator of Multimedia with
instructions on how to do so.

Instructions for uploading audio recordings to CONTENTdm
Open the CONTENTdm Project Client and select the appropriate project.

For a single item:
1. Under Common Tasks, click Add Item.
2. Under Specify the file, click Browse next to the File
Name field. Find the CONTENTdm derivative copy.
Click Open.
3. Click Add at the bottom of the Add Item box. The
audio recording should appear on the Project
Spreadsheet.

For multiple items:
1. Place all items into a single folder.
2.

In the Project Client, under Common Tasks, click
Add Multiple Items.

3. Click Import from a Directory.
4. Click Browse and select the folder with the
CONTENTdm derivative copies.
5. Click Open.
6. Click Next at the bottom.
7. In the next screen, click Add Items. The audio recordings should appear on the
Project Spreadsheet.
38
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For compound items:
1. Place the compound object into a single folder.
2. In the Project Client, under Common Tasks, click
Add Compound Objects.
3. In the Add Multiple Compound Objects screen, click
Add next to Compound Object Wizard. For
recordings with multiple parts, click Document.
4. In the next screen, select the folder in which you saved the compound object. Click
Next.
5. Under Page Information, click Label Pages Using Sequence, and change Page to
Part.
6. In the next screen, Click Finish.

Adding metadata
Please see the “UALR CAHC Audio Metadata” spreadsheet available on the O drive for
further instructions on filling out the metadata fields. Once the metadata is complete,
save it and upload it for approval.

Approval
The Coordinator of Multimedia will also verify if digital audio recordings meets standards.
Preservation masters meeting standards will be transferred to the O:\drive. Once
available on CONTENTdm, CONTENTdm audio recordings meeting standards will be
discarded from the N:\ drive.

Content DM Approval and Indexing
The Coordinator of Multimedia will check audio recordings for the accurate use of
metadata and assign subject headings to audio recordings. Once complete, the
Coordinator will approve the entries. Once approved, the audio recordings will be
indexed immediately.
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Digitizing Video
Digitizing Reel-to-Reel Film
Blackmagic Media Express
The digitization process will use the Blackmagic Intensity Shuttle hardware and
Blackmagic Media Express software. The Blackmagic Intensity Shuttle is the conduit
between the projector and the computer used for digitization.
1. Connect the blue USB cord into the adapter.

2. Plug one end of the Yellow RCA cable into the Out port on the projector, and the
other end into the In port on the Blackmagic Intensity Shuttle.
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.

2.1:

Plug the red RCA cable into the Audio Out port on the projector, and the other end
into the In port on the Blackmagic Intensity Shuttle. Make sure the cable is plugged into
the red port next to the white and yellow ports, not the blue and green
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2.2: Connect the power cord into the projector and surge protector.

3. Assemble the projector by lifting up the arms that hold the tape.

3.1: Release the cover on the front of the projector to view the internal gears. This view
will help you see where to feed the film in the projector.

3.2: Place the reel that contains the film onto the arm and turn the lock up.
42
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Next, place an empty reel on the left arm of the machine. This reel will receive the film as
it is fed through the projector on the other side.

3.3: After the reels are locked and the cover is open, turn the reel on the right arm

clockwise to release the film and begin feeding it into the projector. Always give the film
a little slack in order to prevent it from tearing. When you need more film, turn the reel
instead of pulling. Pulling film manually out of the reel can damage the film.
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3.4: Once the film in successfully fed into the projector, feed it up into the reel on the left

arm. Again, make sure you have an adequate amount of slack in order to feed it up. Once
you have enough slack, place the film into the notch inside of the reel. Turn the reel
clockwise two to three times in order for the film to stay secure in the reel.
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4. Log onto the computer using the .\teacher account and launch Blackmagic Media
Express.

Make sure
the Log and
Capture tab
is selected

4.1: Click Preferences under the Edit menu. Make sure the preferences screen matches
this screenshot.

This step is
important because
it determines how
the file will be
saved.
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5. Switch the main power to On. On the computer, click Capture in Blackmagic
Media Express. Immediately after clicking capture, turn the reel switch to the 5:00
position. The projector will begin playing the film, and Blackmagic will begin
digitizing.
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Rewinding Film
1. Feed the film back into the notch of the original reel on the right arm of the
projector.
2. Turn the reel two or three times to make sure the film is securely in place. Next,
turn the reel switch left to the 9:00 position.

3. When your film is rewound, place the cover back onto the projector, remove the
reels, and collapse the arms back into the projector.
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Digitizing VHS Tapes
Blackmagic Media Express
The digitization process will use the Blackmagic Intensity Shuttle hardware and
Blackmagic Media Express software. The Blackmagic Intensity Shuttle is the conduit
between the projector and the computer used for digitization.
1. Connect the blue USB cord into the adapter.

2. Connect the yellow, red, and white RCA cables into the Out port on the back of the VCR.

2.1: On the other end of the cable cord, connect the yellow, red, and white RCA cables to

the In port of the Blackmagic Intensity Shuttle.
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3. On the computer, launch Blackmagic Media Express. Make sure Log and Capture is
selected.
4. Click Preferences under the Edit menu. Make sure the preferences screen matches
this screenshot.

This step is
important because
it determines how
the file will be
saved.

5. Power on the VCR.

5.1: Insert the VHS tape into the VCR and make sure it is rewound.
5.2: Press Stop on the VCR when tape automatically begins playing.
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5.3: Click Capture on Blackmagic Media Express, and immediately hit Play on the VCR.

The tape will begin playing and Blackmagic will begin digitizing.

Ripping DVDs
1. insert the DVD into the DVD-ROM tray in the computer.

1.1 Hit X to exit the AutoPlay dialog box.
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2. Open the HandBrake software.

2.1: Click Source. Navigate to the DVD drive.

2.2: Click browse to select where the ripped copy will be saved.
2.3: Under Container, make sure MP4 is selected.

3. Click the Video tab. Make sure the video options match this screenshot.
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4. Click the Audio tab. Make sure the audio options match this screenshot.

5. After your settings are properly configured, click Start to begin ripping the DVD.
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Saving and Naming the Preservation Master
The file name will reflect the finding aid’s numbering system. How the file name will be
constructed depends upon whether audio recordings are grouped together in a
collection or are dispersed throughout a collection. The following is a guide to the
terminology used in saving files:

Definitions
•

ualr: Every file name will have ualr at the beginning to emphasize it belongs to UALR
CAHC.

•

ms and orh: ms is the abbreviation for manuscripts; orh is for the oral history
collection.

•

Record group/series/subseries numbers: A manuscript or photograph collection
may be divided into record group, series, or subseries. If this is the case, then include
these numbers number in the file name.

•

Video number: Use vid before the number. The number will be the same as the
identification number given to the original audio recording. Do not number video
recordings based on the sequence in which it is copied.

•

Version: Designate the audio version using one of the following abbreviations: pm =

•

preservation master, dm = CONTENTdm version, aw = access/web version, and ot =
other

•

File type: File names should end according to its format (e.g., “avi”)

Additional Notes:
•

Use lower-case letters when naming files.

•

Use underscores or dashes to represent spaces (e.g., ualr-0001_07 instead of ualr 0001
07).

•

Use na if a field in the file name does not apply

Naming templates
To name recordings that are grouped together and individually identified, use the
following template:
ualr-

ms or ph#_

RG# or Series#_

Series or Subseries#_

Aud#_

Ver.

Type

To name recordings that are dispersed throughout a collection, use the following template:
ualr-

Revised:

ms or ph#_

RG# or
Series#_

Series or
Subseries#_

Box#_

Folder#_

Aud#_

Ver.

Type
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Naming Recordings in the Oral History Collection
For a recording from the Oral History Collection, the file name would be:
ualr-

orh-

vid#_

Ver.

Type

ualr-

orh-0050_

vid01_

pm.

avi

ualr-orh-0050_vid01_pm.avi
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Naming recordings grouped together and individually numbered
The following is an example of how to format a file name. For a preservation master copy
belonging to the Jim Guy Tucker Collection, in record group five, subseries one, video
number 1, this template illustrates how the file name would be derived:
ualr-

ms or ph#_

RG# or Series#_

Series or Subseries#_

vid#_

Ver.

Type

ualr-

ms-0004

05

01

vid0001

pm.

vid

ualr-ms-0001_05_01_vid0001_pm.avi

Naming recordings dispersed throughout a collection
For a video from the John Barker Papers, series 1, box 2, folder 6, the file name would be:
ualr-

ms or ph#_

RG# or
Series#_

Series or
Subseries#_

Box#_

Folder#_

vid#_

Ver.

Type

ualr-

ms-0050_

01_

na_

02_

06_

vid01_

pm.

avi

ualr-ms-0050_02_06_vid01_pm.avi

Saving the Preservation Master
In Audacity, saving has two steps. First, go to Save Project
As. Create a folder on your desktop (you can name it after the
audio number). Save the audacity file in this folder. Next, click
Export under the file menu. Export the audio recording as a
wav file.
Save the wav file in the folder that you created on the desktop.

When putting in numbers for boxes,
folders, and documents, add
preceding 0s based on the total
number of boxes in a record
group/series, folders in a box, and
audio recordings in a folder (e.g., box
02) for a collection with over a
hundred boxes versus box 20 for a
collection with 25 boxes total).

Proceed to create the CONTENTdm copy.
Whenever you create a preservation master, note its creation in the “Item_Digital_Use_Log” under the
“Scanned Images and Usage” tab, located on the N:\ drive in the Logs folder. List the item’s identifier in the
first column, the date scanned in the next, and finally what version of the digitization guidelines you
followed when creating the scan (e.g., for these guidelines, the version number is 3).

Saving the CONTENTdm Version
1. See the instructions above on naming the file (the name will only differ from the
preservation master by using “dm” instead of “pm” for version and “mp4” instead of
“avi” for file type).
2. After you have named it, save it in the same folder as the Preservation Master.
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3. Once you have both files ready, you will transfer the mp4 file to the N:\ drive. Please
see the Coordinator about what to do with the preservation_master file. Oftentimes,
these files are too large, and we will use an alternate method.
In the N:\ drive, find the folder titled Digitization Projects. Find the folder titled
Digitization Projects. In it, locate the audio file. Click on it, and then select the folder
named for the audio recording’s manuscript collection number. Open this folder.
Place the video files in the CONTENTdm folder. Once transferred, discard any copies on
your desktop.

Digital Copies Approval
The Coordinator of Multimedia will verify if digital video recordings meets standards.
Preservation masters meeting standards will be transferred to the O:\drive. Once
available on CONTENTdm, CONTENTdm audio recordings meeting standards will be
discarded from the N:\ drive.
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Uploading Media into CONTENTdm
Getting started
To add digital objects to CONTENTdm, you will need to work with CONTENTdm Project
Client. If this is your first time working in Project Client, you will need to create a log-in
account in World Cat. Contact the Director of Technology and Digital Initiatives with your
World Cat log-in information for access to Project Client.
17. Once you’re in the Project Client, click New in the Project menu. Enter your log-in.
The Server URL is: https://server15728.contentdm.oclc.org/
18. In the next screen, choose the appropriate collection you want to import. Collection
names are based off of media types. This will serve as a workspace for adding
metadata to digital photographs. Alternatively, you can also work in an Excel
Spreadsheet to upload metadata. Please contact the Coordinator of Multimedia with
instructions on how to do so.

Instructions for uploading audio recordings to CONTENTdm
Open the CONTENTdm Project Client and select the appropriate project.

For a single item:
19. Under Common Tasks, click Add Item.
20. Under Specify the file, click Browse next to the File
Name field. Find the CONTENTdm derivative copy.
Click Open.
21. Click Add at the bottom of the Add Item box. The
audio recording should appear on the Project
Spreadsheet.

For multiple items:
22. Place all items into a single folder.
23. In the Project Client, under Common Tasks, click
Add Multiple Items.
24. Click Import from a Directory.
25. Click Browse and select the folder with the
CONTENTdm derivative copies.
26. Click Open.
27. Click Next at the bottom.
28. In the next screen, click Add Items. The audio recordings should appear on the
Project Spreadsheet.
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For compound items:
29. Place the compound object into a single folder.
30. In the Project Client, under Common Tasks, click
Add Compound Objects.
31. In the Add Multiple Compound Objects screen, click
Add next to Compound Object Wizard. For
recordings with multiple parts, click Document.
32. In the next screen, select the folder in which you saved the compound object. Click
Next.
33. Under Page Information, click Label Pages Using Sequence, and change Page to
Part.
34. In the next screen, Click Finish.

Adding metadata
Please see the “UALR CAHC Video Metadata” spreadsheet available on the O drive for
further instructions on filling out the metadata fields. Once the metadata is complete,
save it and upload it for approval.

Approval
Once the project is complete, the Coordinator of Multimedia will approve the new items
before they are accessible on the web. Along with checking metadata in CONTENTdm,
the Coordinator of Multimedia will also confirm whether the digital copies meet CAHC’s
standards.

Content DM Approval and Indexing
The Coordinator of Multimedia will check audio recordings for the accurate use of
metadata and will assign subject headings to audio recordings. Once complete, the
Coordinator of Multimedia will approve the entries. Once approved, the video recordings
will be indexed immediately.
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Appendix I
Historypin (optional)
To encourage the public to interact with our digital collections, the CAHC may choose to
select photographs to highlight on Historypin. Historypin is a user-friendly website
geared toward the public that allows anyone to “pin” photographs on its interactive map
and add their personal stories to them. Other features allow users to add audio clips,
superimpose photographs on Google’s street-view map, and create tours to guide
people through a series of photographs across space and time.

Selection
The Archivist will select photographs from a digital collection. Photographs that have
clear copyright violations or other legal issues will not be uploaded. Strong candidates for
inclusion in Historypin include the following:
•

Photographs with readily identifiable locations in Arkansas

•

Photographs with readily identifiable addresses

•

Photographs that are representative of a person’s life, subject, or place when
creating

Historypin tours/collections in conjunction with an exhibit

Selection of photographs within a photograph collection
If an entire photograph collection is nominated for inclusion in Historypin, these are the
bare minimum
qualifications a photograph must possess to be included:
•

Photographs must at least be identified at the city/town level.

•

Photographs must have a date (a circa date qualifies a photograph)

•

Photographs must not be intellectually owned by other repositories/archives

•

Photographs are NOT mass-produced postcards

Subject matter should not already be represented in Historypin (e.g., City Hall in Little
Rock, ca. 1930s). If there are multiples of photographs with similar subjects from the
collection, select which one is the best representative.
If after this criteria has been applied, and 50 or more photographs still qualify for inclusion
from the collection, these additional criteria may be applied:
•

Photographs must have a street location - (Or if there are still too many)

•

Select 25-50 of the best representative photographs of the collection

•

Uploading

Only JPEG version of images can be uploaded. Historypin then automatically converts
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items to its standards.

Adding Metadata
Since Historypin is for the public, its metadata is not as granular. Users can also add their
own stories to a photograph. We will use the photograph’s metadata in its CONTENTdm
record to create metadata for Historypin. The following are the elements that Historypin
uses and how they align with ourCONTENTdm metadata:

Basics
•

Title : Title

•

Date : Date

•

Place : Coverage and/or Address

•

Description : Description

•

Tags : no equivalent

Additional Info
•

Liscensed : no equivalent, select either “Copyright © all rights reserved,” or “Public
Domain”

•

Copyright holder : no equivalent, leave blank

•

Author : Creator

•

Original link : no equivalent, use link to CONTENTdm record

•

Repository/Archive: Publisher (will always be UALR Center for Arkansas History and
Culture

•

Notes : Identifier

Note on address
It will not always be possible to include latitude and longitude coordinates or specific
addresses. Duringthe selection process, CAHC will determine what photographs we will
be able to gather this information on. If we uncover the latitude and longitude
coordinates or a specific address, this information will be added to the photograph’s
CONTENTdm record.

Final step
To maintain control of our digitized materials, it is critical to record how and when an item
is digitized.
Note an item’s use in Historypin in the “Item_Digital_Use_Log” under the “Scanned Images
and Usage” tab, located on the N:\ drive in the Logs folder.
In the log, look for the item’s identifier in the first column. If it has already been listed,
then simply type the date in the Historypin column. If it is not already on the log, then
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add its identifier in the first column and then the date.

Youtube (optional)
CAHC will use Youtube to share videos with the public. In addition to having over
hundreds of millions of users, Youtube is the de-facto website for sharing videos across
the web. Historypin and Facebook also accepts Youtube video uploads on its site.

Selection
Audio or audiovisual materials from CAHC’s collections that supplement our digital
exhibits or are in high demand from our users are strong contenders for inclusion on
Youtube. Videos that have clear copyright violations or other legal issues will not be
uploaded.

Creating Videos
For existing videos
Open the video in Windows Live Movie Maker and save it as a Movie Maker Project
(.wlmp). Make anyadjustments needed. Next, select “Save Movie” and choose “For
Computer.” Save it as a Windows
Media Video File (.wmv).
On the N:\ drive, find the folder titled “Digitization Projects.” Then click on the Audio
folder, and then locate the specific folder for the project, which will be named by its
manuscript collection number. Open this folder. Either find or create a Youtube folder in
which this file will be saved.

For combining audio and images
To create a video by combining audio and images, open Windows Live Movie Maker. Add
an image by selecting “Add videos and photos.” To add audio, select “Add music.” Under
the “Project” ribbon, select “Fit to Music.”
Make any other adjustments needed. Next, select “Save Movie” and choose “For
Computer.” Save it as a Windows Media Video File (.wmv).

Uploading
Log into CAHC’s Youtube account. Go to Video Manager and click the upload button.
Once the video is successfully uploaded, add the metadata. Youtube automatically
makes videos public, so if you are not yet ready to publicize the video, then set the video
to “Private.”

Adding metadata
Under basic information, fill out the following fields: Title, Description, and Tags. Create a
title that includes keywords that a user would likely use to find a video like ours. For
instance, in the case of a video of Winthrop Rockefeller recalling his Texas oil field days,
naming it “The Roughneck Rockefeller” may sound catchy, but it does not improve the
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video’s chances of being retrieved. However, if you named it “Winthrop Rockefeller
recalls time at Texas oil fields,” having the words “Winthrop Rockefeller” and “Texas oil
fields” gives the video a greater chance of being retrieved. For description, be concise
and use 3-4 sentences maximum. Also keep in mind that this is a national audience,
unlikely to be familiar with Arkansas history.
Under advanced settings, note the video location and recording date if available.

Final step
To maintain control of our digitized materials, it is critical to record how and when an item
is digitized.
Note an item’s use in Youtube in the “Item_Digital_Use_Log” under the “Scanned Images
and Usage” tab, located on the N:\ drive in the Logs folder.
In the log, look for the item’s identifier in the first column. If it has already been listed,
then note the Youtube title and link in the Youtube column and the date in the Youtube
Date column. If it is not already on the log, then add its identifier in the first column and
then fill out the appropriate columns.

Facebook
CAHC may choose to share digitized materials on its Facebook page, which primarily
serves as a way for keeping users informed about updates and news concerning the
archives.

Selection
Selection for what to share on Facebook is open. So long as there are no clear copyright
violations or other legal issues, the CAHC encourages a wide variety of digitized materials
to be shared with users. Ideas for how to select materials include the following:
•

Current projects

•

Current exhibits

•

Current events resembling past events

•

Anniversaries, holidays, public observances

•

This Day in History”-esque facts

•

Strange and unusual items

Balance of content, between “serious” and more “lighthearted” entries, should also be
considered. In addition, be mindful of the institution’s image when posting content,
especially when selecting items relating to current events. Consult with colleagues before
posting items relating to hot topics or current controversies.

Uploading
Uploaded content should follow the digitization standards for web access materials (e.g.,
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the resolution for photographs is 72 dpi).
To upload, log into CAHC’s Facebook account. Click on “Add Photo/Video.” Next, add the
metadata.

Metadata
Facebook only has a description field. Briefly provide context for the digitized item as
well as note what collection it is from. If available, credit the creator of the item.

Final step
To maintain control of our digitized materials, it is critical to record how and when an item
is digitized. Note an item’s use in Facebook in the “Item_Digital_Use_Log” under the
“Scanned Images and Usage” tab, located on the N:\ drive in the Logs folder.
In the log, look for the item’s identifier in the first column. If it has already been listed,
then simply type the date in the Facebook column. If it is not already on the log, then add
its identifier in the first column and then the date.
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